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Chapter 1: 
Mapping Assessment Areas 

Mapping in CRA Wiz is a valuable tool that helps institutions complement their lending analysis. 

There is a variety of data available in CRA Wiz, including business, product, economic, projected 

business, and geodemographic data. You can use this data to create a map of a specific geographic 

area. The geographic area you use for your map can either be an existing assessment area or the area 

for which you have activity in your current file--all the areas in which your institution has loans, or a 

geographic area you define.   

For more information on mapping functionality in CRA Wiz and Fair Lending Wiz, refer to the 

following topics: 

Accessing the Mapper 

Refreshing Map 

Creating Assessment Area Map 

Adding Selected Area to Assessment Area 

Working with Custom Coordinate Files 

Mapping Peer Branches 

Displaying Selected Area Only 

Plotting Address 

Printing Maps 

Exporting Maps 

Premium Mapping Modules 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
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Accessing the Mapper  

To access the Mapper, follow these steps: 

1.  Click the Analysis tab.   

The software displays the Analysis view bar. 

 

2.  Click the Map button. 

 

The software displays the Mapper main screen in a separate window: 
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Note:   

The map image will default for the region of mapping data that you 

have installed. 
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Creating Map of an Assessment Area 

You can use CRA Wiz to create a map of your assessment area. 

You can enhance the display of information on your map by adding layers. 

Layers include the following: 

 Boundary layers - these include MSAs, congressional districts, bodies of water, and parks. 

 Linear layers - these include railroad tracks and roads. 

 Point layers - these indicate the location of airports, places of worship, and schools. 

 Themes - add or remove themes from the map. 

To create a map, use the following procedures: 

Setting Map Parameters Overview 

Adding Map Layers 

Applying Labels to Map Layers 

Modifying Layer Display 

Modifying Existing Themes 

Applying Theme to Current File 
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Setting Map Parameters Overview 

To set map parameters, you use the options available in the Map Settings pane: 
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Options include: 

 Geographic Breakdown - (1) - Use the options in the Geographic Breakdown By section of 

the Map Settings pane to select at which geographic level you want to display map 

information--Census Tract, County, State, or MSA. 

 Selecting Area - (2) - Use the options in the Data Files Displayed By section of the Map 

Settings pane to display geographic information from your current file, using a previously 

saved assessment area, or by defining a custom assessment area. 

 Adding Themes - (3) - Use the options in the Customize Your Display section of the Map 

Settings pane to add thematic information to a map including thematic shading, thematic 

overlay, dot density, pie charts, or data labels. 

Important! After configuring all of the necessary map parameters in the Map Settings pane, apply the 

changes to your map using the Map Settings pane Apply button - (4). 

For more information on setting map parameters, refer to the following topics: 

Accessing Map Settings Pane 

Selecting Geographic Breakdown 

Selecting Area 

Adding Themes 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Creating%20and%20Saving%20%20Assessment%20Areas.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Creating%20and%20Saving%20%20Assessment%20Areas.htm
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Accessing Map Settings Pane 

You use the Map Settings pane to select a geographic area for a map. To access the Map Settings 

pane, do the following: 

On the Mapper main screen, click the Map Configuration Settings link: 

 

The software displays the Map Settings pane: 
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Selecting Geographic Breakdown 

You use the options in the Geographic Breakdown By section of the General panel of the Map 

Settings pane to select the geographic level at which the map displays information for an area: 

 

To select a geographic breakdown, follow these steps: 

1. In the Geographic Breakdown By panel of the Map Settings pane, select one of the following 

option buttons: 

 Census Tract: 
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 County: 

 

 MSA: 
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 State: 

 

2. Click the Apply link located at the top-right corner of the Map Settings pane: 

 

The software applies the geographic level. 
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Selecting Area 

You use the options in the Data Files Displayed By section of the General panel of the Map Settings 

pane to define the specific geographic area you want to display on the map: 

Note: For ease of selection, the software saves the last assessment area used. 

 

Available options include: 

 Current File Area - Displays data for geographic areas in which your institution had loan 

activity, based on the currently active file in the system.  

 User Defined Assessment Area - Displays geographic data for a Saved Assessment Area.  

 Custom Area - Displays geographic data for areas (states, MSAs, counties, census tracts) you 

select. 

To select an area, follow these procedures: 

Displaying Current File Area 

Displaying Assessment Area 

Displaying Custom Area 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Introduction%20to%20Assessment%20Areas/Introduction%20to%20Assessment%20Areas.htm
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Displaying Current File Area 

To display a map of geographic data from the loan file that is currently active in CRA Wiz, follow 

these steps: 

1. In the Data Files Displayed By section of the General panel of the Map Settings pane, select 

the Current File Area option button: 

 

2. Click the Apply link located at the top-right corner of the Map Settings pane. The software 

displays a map of the geographic data in your currently active file. 

Displaying Assessment Area 

To display a map of a pre-defined and saved assessment area, follow these steps: 

1. In the Data Files Displayed By section of the General panel of the Map Settings pane, click the 

Change Your Assessment Area link: 

 
 

The software displays the User Defined Assessment Areas pane: 

 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Introduction%20to%20Assessment%20Areas/Introduction%20to%20Assessment%20Areas.htm
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2. From the list of saved areas, select the area for which you want to display a map. Note: You 

can select multiple areas. 

Important! The list of saved areas that the software displays is 

based on your current Census Year selection. For example, if 

Census Year is set to 2000, the software displays only those saved 

assessment areas associated with the 2000 Census Year. If Census 

Year is set to 2010, the software displays only those saved assessment 

areas associated with the 2010 Census Year. 

3. Click the Apply link located at the top-right corner of the User Defined Assessment Areas 

pane. The software displays the Map Settings pane. 

 

4. Click the Apply link located at the top-right corner of the Map Settings pane: 

 
 

The software displays the map. 

Displaying Custom Area 

To display a map of geographic areas that you select, follow these steps: 

1. In the Data Files Displayed By section of the General panel of the Map Settings pane, click the 

Select Your Area link: 

 
 

The software displays the Select Custom Area pane: 
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2. Use the tree view to select the areas you want to include in your map: 

 

3. Click the Apply link located at the top-right corner of the Select Custom Area pane. The 

software displays the Map Settings pane. 

4. Click the Apply link located at the top-right corner of the Map Settings pane. 
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The software displays a map of the area(s) you selected. 

Adding Themes 

You use themes to create geographical representations showing the distribution and relationship of 

the information your institution maintains in your data files within the geographic areas your 

institution serves. 

Themes include the following: 

 Thematic Shading - Represented with geographies, for example: census tracts, being shaded 

various colors on the map 

Note: By default, the system uses a regulator suggested color palette 

for displaying map theme ranges. For more information, refer to the 

description of the Style tab in Modifying Existing Themes. 

 Thematic Overlay – Represented with geographies, for example: census tracts, displaying 

with cross-hatches or other transparent patterns on a map. 

 Dot Density – Represented with geographies being populated with dots to represent the 

presence of selected demographic information with the area. Can be configured based on 

display preferences, for example 1 dot = 1 loan or 1 dot = 100 loans. 

 Pie Chart - Display demographic variables in pie chart form. You can select up to six 

variables per demographic type. 

 Data Labels - Provides count of a variable in a Census Tract. You can apply up to three labels 

per demographic type. 



Mapper User Guide 
 

 20 CRA Wiz and Fair Lending Wiz 

To select the theme for the map, follow these procedures: 

Adding Thematic Shading 

Adding Thematic Overlay 

Adding Dot Density 

Adding Pie Charts 

Adding Data Labels 

Adding Thematic Shading 

To add thematic shading to a map, follow these steps: 

1. Click the Map Configuration Settings link: 

 
 

The software displays the Map Settings pane. 
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2. In the Customize Your Display pane, click the Select a Layer link located under the Choose 

Your Data: Thematic Shading section: 
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The software displays the Map Data pane: 

  

 

3. Use the tree view to select the data you want to display on the map. For example, select the 

GeoDemographic Data folder. 

The software displays the contents of the GeoDemographic folder. 

4. Select the Income folder. 

The software displays the themes available in the Income folder. 

5. Select, for example, Income as % of MSA Median: 

 

6. Click the Apply link.  

Note: Income Category is another option to use to display tract income categories. This selection is 

useful for individuals not familiar with the percentage categories for tract income. 

The software displays the Map Settings pane. 

7. Click the Apply link located at the top-right of the Map Settings pane. 
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The software does the following: 

 Adds thematic shading to your map (Income as % of MSA Median).  

 Adds Income as % of MSA Median ranges to the legend. 

 
 

Note: While reviewing the legend you see that the four income 

ranges defined by government regulation (low, moderated, middle, 

and upper) are displayed. The number in parentheses is the number 

of census tracts in each range. There may be a fifth category listed, 

All Others. All Others represents tracts that do not have households 

with reportable income. There are several reasons why this might be 

the case, including: 

 No family income data. 

 No population with families. 

 No population (the entire census tract, might, for example, be an airport). 
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Adding Thematic Overlay 

To add a thematic overlay (cross-hatching) to a map, follow these steps: 

1. Click the Map Configuration Settings link: 

 
 

The software displays the Map Settings pane. 
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2. In the Customize Your Display pane, click the Select a Layer link located under the Choose 

Your Data: Thematic Overlay section: 

 
 

The software displays the Map Data pane: 

 

3. Use the tree view to select the data you want to display on the map. For example, select the 

GeoDemographic Data folder. 

The software displays the contents of the GeoDemographic folder. 

4. Select the Population folder. 

The software displays the themes available in the Population folder. 

5. Select, for example, Minority: 

 

6. Click the Apply link. The software displays the Map Settings pane. 



Mapper User Guide 
 

 26 CRA Wiz and Fair Lending Wiz 

7. Click the Apply link located at the top-right of the Map Settings pane. 

The software does the following: 

 Adds a thematic overlay to your map. 

 Adds associated ranges to the legend. 
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Adding Dot Density 

To add dot density data to a map, follow these steps: 

1. Click the Map Configuration Settings link: 

 
 

The software displays the Map Settings pane: 

 

 

2. In the Customize Your Display pane, click the Select a Layer link located under the Dot 

Density section: 
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The software displays the Map Data pane: 

 

3. Use the tree view to select the data you want to display on the map. For example, select the 

GeoDemographic Data folder. 

The software displays the contents of the GeoDemographic folder. 

4. Select the Population folder: 

The software displays the themes available in the Population folder: 

 

5. Select, for example, scroll down the list and select Minority: 
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6. Click the Apply link. The software displays the Map Settings pane. 

7. Click the Apply link located at the top-right of the Map Settings pane. 

The software does the following: 

 Adds dot density to your map. 

 Adds the calculated "Per Dot" value to the legend. For example, 1 Dot = 118. 
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Adding Pie Charts 

To add pie charts to a map, follow these steps: 

1. Click the Map Configuration Settings link: 

 
 

The software displays the Map Settings pane: 
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2. In the Customize Your Display pane, click the Select a Layer link located under the Pie 

Chart section: 

 
 

The software displays the Create a Pie Chart dialog box: 

 

3. Use the Dataset drop-down menu located at the top of the dialog box to select the data set 

(Business GeoDemographic Data, GeoDemographic Data, Projected GeoDemographic Data, 

Transitional Census 21010, and Current File) whose variables you want to add to the pie 

charts. 

4. Use the tree view in the left-hand list box to display the variables you want to display in the 

pie charts.  

5. To add a variable, select the checkbox for the variable then click the right-facing arrow button 

. The software displays the variable in the right-hand list box. 

Note: To remove a variable, click the left-facing arrow button 

. To remove all selected variables, click the double-left-

facing arrow button . 

Note: You must select a minimum of two (2) variables to create a pie 

chart, and can select up to a maximum of six (6) variables. 
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Note: If you add multiple variables, the software enables the Up 

and Down buttons located at the bottom 

Selected Data Layers list box. Select a layer variable then click the Up 

or Down buttons to move the variable up or down the list: 

 

6. When you have finished adding variables, click the OK button. The software displays the Map 

Settings pane. 

7. Click the Apply link located at the top-right of the Map Settings pane. 
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The software does the following: 

 Adds the pie charts to your map. 

 Adds associated pie chart descriptions to the legend. 

 

Adding Data Labels 

To add data labels to a map, follow these steps: 

1. Click the Map Configuration Settings link: 

 
 

The software displays the Map Settings pane. 
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2. In the Customize Your Display pane, click the Select a Layer link located under the Add 

Data Labels section: 

 
 

Note: You can configure the other two Select a Layer links to 

display a total of three data labels on your map. 

The software displays the Map Data pane: 
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3. Use the tree view to select the data you want to display on the map. For example, select the 

Business GeoDemographic Data folder. 

The software displays the contents of the Business GeoDemographic 

Data folder: 

  

 

4. Select the Number of Businesses folder. 

The software displays the themes available in the Number of 

Businesses folder: 
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5. Select, for example, Farms less than or equal to 1 Mil in Revenues: 

 

6. Click the Apply link. The software displays the Map Settings pane. 

Note: Repeat Steps 2 through 6 to display two additional data labels 

on the map, for a total of three labels. For the purposes of example, 

repeat these steps to add Non-Farm Business less than or equal 

to 1 Mil in Revenues. 

7. Click the Apply link located at the top-right of the Map Settings pane. 
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The software adds labels to the map: 
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Adding Map Layers 

To add layers (features) to a map, follow these steps: 

1. Click the Map Layer Control link: 

 

The software displays the Layer Selection pane: 
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2. To turn a layer on, select the checkbox for a layer, for example, Interstate Highways: 
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3. To configure display options for the layer, click the name for the item:  

 

The software displays the Layer Options - [Name of Layer] dialog 

box: 

  

 

4. Use the various options in the dialog box to configure how you want the layer to display on 

the map. For more information, refer to Modifying Layer Display. 

5. Click the OK button. The software displays the Layer Selection pane. 

6. Click the Apply link located at the top-right corner of the Layer Selection pane: 
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The software does the following: 

 Displays the layers (features) on the map. 

 Adds the new layers to the legend. 
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Applying Labels to Map Layers 

Using the Layer Options dialog box, you can add labels to the three map layer types (geographic 

boundaries, lines, and points). 

To add labels to a layer, follow these steps: 

1. Below the map theme legend on the left side of the map, double-click on a currently displayed 

layer:  

 
 

The software displays the Layer Options - [Name of Layer] dialog 

box: 
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2. From the Current Setting drop-down menu located in the Labels section of the dialog box, 

select Auto Label: 

 

3. To change label display options, click the Change Label Display button. 

The software displays the Label Preferences dialog box: 
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4. Use the provided options in the five tabs (Visibility, AutoLabel, Style, Position, and Rules) 

to customize label settings such as font, color, and position. 

5. When you have configured label options, click the OK button.  

The software displays the Layer Options dialog box. 

6. Click the OK button in the Layer Options dialog box. 

The software displays label names on the map. 
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Modifying Layer Display 

Using the Layer Options dialog box, you can modify the display options for the following map 

layer types: 

 Geographic Boundaries - Modify the style (fill type, color, transparency level, width, etc) of 

borders for geographic boundaries such as States or Counties. 

 Points - Modify the display symbols and style used for points such as schools and hospitals. 

 Lines - Modify the style used for lines such as streets, highways, and railroads. 

To modify layer display, follow these steps: 

1. Below the map theme legend on the left side of the map, double-click on a currently displayed 

layer:  

 
 

The software displays the Layer Options - [Name of Layer] dialog 

box: 
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2. To change the display properties of a layer, click one of the three buttons located in the Style 

section of the Layer Options dialog box: 

 Note: The type of the layer you selected in Step 1 determines which of the three buttons is 

enabled in the dialog box. 

 - Click to modify the style for a geographic area. 

  - Click to modify the style for a line. 

 - Click to modify the style for a point. 

The software displays one of the following Style dialog boxes: 

 Area Style dialog box - Use the options provided in the two tabs (Fill and Border) of 

this dialog box to change the style and color of the fill for a geographical boundary 

layer, as well as the style, width, and color of the area's borders. 

 Line Style dialog box - Use the provided options to change the style, color, and width 

of a line layer such as a street or railroad. 
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 Symbol Style dialog box - Use the provided options to change the font family used to 

display a symbol, along with the symbol type and color.  

3. When you have configured the necessary layer options in a dialog box, click the OK button: 

 
 

The software displays the Layer Options dialog box: 

4. Click the OK button. 

The software applies your changes to the layer.   
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Modifying Existing Themes 

You can modify an existing theme by changing map legend display options such as range colors 

used, calculation method, number of ranges, rounding, labels, and more. 

To modify an existing theme, follow these steps: 

1. Do one of the following: 

 Double-click the map legend: 

 

--OR-- 

 Click the Modify Theme link located beneath the map legend: 
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The software displays the Modify Ranged Theme dialog box: 
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The dialog box is divided into three tabs. Each tab displays legend options on the left, and a 

live preview of your changes to the map legend on the right: 

 Settings tab - Select a range breakdown (Equal Count, Equal Ranges, Natural 

Break, Standard Deviation, and Custom) (1), select the number of ranges displayed 

in the legend (2), enable rounding for range values (3), and create custom ranges 

by selecting a range in the list box (4) and then entering a new minimum (> = 

Min) and maximum (< Max) range in the provided text fields (5): 
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 Style tab - Click the Range Style button for a selected range to modify the display 

style for a selected range including fill color, transparency, border style, and border 

thickness (1). Note: The Use Regulator Suggested Color Palette 

checkbox/option is enabled by default for demographics with four ranges (2). To 

override this option, de-select the checkbox then use the Start Style and End Style 

buttons in the Spread Styles section to configure customized color spreads for a 

data range (3): 
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 Legend tab - Use to modify the legend title and subtitle (1). Click the font buttons 

located next to each legend title to change display font options (2). Click the 

legend display border button (3) to add a border around the legend (Note: this 

option is disabled by default. To enable, select the Display Border checkbox). 

Modify range labels in the legend by selecting a range in the Range Labels list 

box (4), then modifying the selected label in the Selected Range Label text field 

(5). If you are modifying the range labels, select the Use Customized Range 

Labels checkbox (6). Click the range labels Font button (7) to change range label 

font options. You can also change the range label display order by selecting the 

Ascending or Descending option buttons (8): 

 

2. Modify legend options as necessary in the tabs then click the OK button. 

The software updates the legend and/or map theme. 
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Applying Theme to Current File 

CRA Wiz and Fair Lending Wiz has four theme types available in its Map module:  

 Thematic Shading 

 Thematic Overlay 

 Dot Density and  

 Pie Charts 

Users frequently utilize GeoDemomographic or Business Demographic data, to apply themes to their 

map. The Income as a % MSA Median variable available in GeoDemographic Data is a commonly used 

variable when applying thematic shading to a map. 

In addition to using demographic data sets to create thematic maps, the CRA Wiz and Fair Lending Wiz 

Mapper allows users to apply themes based on data found in their institution’s data files. As an example, 

an institution may wish to apply thematic shading to census tracts in their assessment area based on the 

number of loans originated to low and moderate income applicants. 

To create this map, follow the following steps: 

Note: Prior to creating to your map, ensure that your Current File in the Mapper is set and fulfills your 

requirements for analysis. Please refer to the Refreshing Map topic for information on how to refreshing 

your Current File in the Map. 

1. Click the Map Configuration Settings link. 

2. In the General section, confirm the following settings: 

• Geographic Breakdown By: Census Tract - 1 

• Data Files Displayed by: User Defined Assessment Area Current: <<your desired AA>> - 2 

• Map View: Current - 3 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
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3. In the Customize Your Display section, select the Select a Layer link available for Thematic 

Shading: 

 
 

The software displays the Map Data dialog box. 

4. In the Map Data dialog box, click on the Current File folder to expand its contents: 
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The software displays several predefined filters available to filter your 

Current File as well as an option to create a new custom filter: 

 

Note about Pre-Defined Filters 

Three of the most commonly utilize filters are available as default 

selections: 

 Current File: All 

 Current File: Active Filter 

 Current File: Originated 

 Current File: Originated and Purchased 

To apply a predefined filter to your Current File, simply select the 

radio button for your desired filter: 

 
 ...and click the Apply button in the Map Data dialog box: 
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5. To create a new custom filter, click the Add New link: 

 

Note: For the purposes of this example, we will create a custom 

filter based on Action = Originated and Application Income = 

Low & Moderate. 

The software displays the Filter Your Current File dialog. Use this 

dialog box to select filter criteria: 
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6. Double-click Loan Information. 

The software displays the available types of Loan Information. 

7. Double-click the Product Information folder. 

8. Double-click the Action folder. 

The software displays the available Action codes. 

9. Select Originated: 

 

10. Scroll down to the Applicants Information and double-click this folder: 

 

The software displays the available types of Applicants Information. 

11. Scroll down to the Income as % MSA Median (Custom Range) folder and double-click it. 

The software displays the available options for Income as % MSA 

Median. 
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12. Select both Low < 50% and Moderate 50 – 79.9999%: 
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13. In the Current File Name field, enter a filter name. For example: Originations_Low_Mod: 

 

Note: Filter names cannot contain spaces. 

14. Click the Apply button. 

The software does the following: 

• Closes the dialog box. 

• Displays Originations_Low_Mod under Current File: 
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15. With the radio button for the Originations_Low_Mod filter selected in the Map Data dialog 

box, click the Apply button: 

 

The software does the following: 

• Closes the dialog box. 

• Displays Originations_Low_Mod as the Current: value for Thematic Shading: 

 

16. On the Map Configuration Settings drop-down list, click the Apply button. 

The software does the following: 

• Closes the Map drop-down list. 

• Adds thematic shading to census tracts based on the number of loans originated to low and 

moderate income applicants: 
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Chapter 2: 
Utilizing Other Map Tools 

Refreshing Map 

 
In some cases, when you modify your loan file in CRA Wiz and Fair Lending Wiz, you will need to 

manually refresh the Mapper so that those file changes propagate to the Mapper module: 

 When changing the Current File 

 When applying a filter to a file 

 When changing Activity Year (From the CRA Wiz and Fair Lending Wiz Options menu, 

select Year and then an Activity Year) 

 When changing Census Year (From the CRA Wiz and Fair Lending Wiz Options menu, select 

1990, 2000, or 2010 Census Boundaries) 

To refresh the map after making one or more of the above loan file changes, follow these steps: 

1. Switch to the Mapper.  

2. Click the Refresh button located in the Mapper tool bar: 

 

The software updates the file information in the Mapper. 

Note: If you changed the current file or updated the Census Year, 

you can confirm your changes in the Mapper by checking the File 

display located on the right side of the screen: 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Editing/Editing%20Data/Sorting%20and%20Filtering.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
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Using Area Selection Tools 

 
You use the area selection tools to select multiple, specific geographical areas on a map, for example, 

one or more Census Tracts. You use the tools to draw around the areas you want to select.  

After you have selected the area, you can use the Display Selected Area Only command to display only 

that area on the map.  

To select an area, follow these steps: 

1. In the Mapper tool bar, click one of the following selection tool buttons: 

 

 Radius -  - Select areas using a circular selection box. 

 Marquee -  - Select areas using a rectangular selection box. 

 Polygon -  - Select areas using a multi-sided selection box. 

 Single Select -  - Select a single area. 

2. Drag your mouse pointer over the areas you want to select. 

The software draws the shape of selection tool you selected in Step 1 

(in the below example, the Radius select tool): 
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3. Release your mouse button. 

The software highlights the area: 

 

Note: If you selected the wrong areas, click the Unselect All  

button located in the tool bar. The software deselects the areas. 

Repeat Steps 2 and 3. 

4. From the Edit menu, select Outline: 



Mapper User Guide 
 

 66 CRA Wiz and Fair Lending Wiz 
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The software outlines the area you selected: 

 
 

Note: To clear the outline, select Clear Outline from the Edit 

menu: 
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Displaying Selected Area Only 

You may notice that by default, the software displays areas beyond an 

mapped assessment area: 

 

If you prefer to have only the area that represents the assessment area 

appear on the map, use the Display Selected Area Only command to 

remove all areas falling outside of the assessment area. 

Note: For information on how to select an area using the Mapper area 

selection tools, refer to the Using Area Selection Tools topic. 

To display a selected assessment area only on a map, follow these steps: 

1.  From the Edit menu, select Display Selected Area Only: 
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The software removes map areas outside of the assessment area: 

 
 

2.  If you want to display areas outside of the assessment area, from the Edit menu, select Display 

Selected and Surrounding Area: 
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The software re-displays the surrounding map areas. 
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Adding Selected Area to Assessment Area 

You can select areas specific geographic areas in the map and then send the selected map area(s) 

directly to the Create Areas section of CRA Wiz to create a new assessment area. The Add Selected 

Area to Assessment Area option populates the Create Areas grid with all of the relevant State, 

MSA, County, and Census Tract information from the selected area of the map. You can then save 

this area for later use.  

Note: For more information on using Assessment Areas in CRA Wiz and Fair Lending Wiz, click 

here.  

To add selected map area(s) as an assessment area in CRA Wiz and Fair Lending Wiz, follow these 

steps: 

1. Select the Zoom In tool located in the tool bar: 

 

2. In the map, click the geographical area(s) you want to enlarge: 

 
 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Introduction%20to%20Assessment%20Areas/Introduction%20to%20Assessment%20Areas.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Introduction%20to%20Assessment%20Areas/Introduction%20to%20Assessment%20Areas.htm
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The software zooms into the area: 

 

3. To select an area, click the Select tool located in the tool bar: 

 

Note: You can also select areas using the Radius  , Marquee 

, and Polygon  selection tools located next to the Select tool 

in the tool bar. 
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4. In the map, click the geographic area you want to select (in the below example, a State). The 

software selects the area: 

 

Note: To select multiple areas, hold down the Control (Ctrl) key on your keyboard while 

clicking on additional areas. 

5. From the Tools menu, select Add Selection to Assessment Area: 

 

The software sends the selected area to CRA Wiz and Fair Lending Wiz. 
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6. Switch to CRA Wiz and Fair Lending Wiz and note that the selected area data has been added 

to the Assessment Area screen: 

 

7. Save the assessment area. 

Note: For more information on how to save an assessment area, 

click here.  

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Introduction%20to%20Assessment%20Areas/Introduction%20to%20Assessment%20Areas.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Creating%20and%20Saving%20%20Assessment%20Areas.htm
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Working with Custom Coordinate Files 

Custom coordinate files can be used to plot loan records contained in your data files as points on a 

map. Custom coordinate files are also commonly utilized to map branch and ATM locations. For 

more information, refer to the Importing a Branch File topic. 

Note: For a file to be eligible to be plotted as a custom coordinate file, it must be geocoded (ie, 

contain latitude and longitude information). 

To add a custom coordinate file to your map, follow these steps: 

1. In the main map screen, click the Map Layer Control link: 

 
 

The software displays the Layer Selection pane: 

 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Importing/Importing%20a%20Branch%20File/Importing%20a%20Branch%20File%20Overview.htm
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2. Scroll to the bottom of the tree view and click the Custom Coordinates item to display 

Custom Coordinates options: 

 

3. Select one of the following: 

Note: You can select multiple coordinate files for display on a map. 

For example, you can display points from your currently active file 

along with existing coordinate files. 

 Add File - Click this link if you want to add a custom coordinate file. The software 

displays the Add Custom Coordinate File dialog box: 

 

Click the ellipses button (1) to display the Open dialog 

box. Use the dialog box to select a file that you have 

already imported into CRA Wiz and Fair Lending Wiz. 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Importing/Introduction%20to%20Importing/Introduction%20to%20Importing.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Importing/Introduction%20to%20Importing/Introduction%20to%20Importing.htm
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Note: You cannot select Peer Data files. When you have 

selected a file, the system enables the Add Filter link (2). 

If you want to filter your coordinate file, click this link to 

display the Filter dialog box. Use the tree view to select 

filter criteria and then click the Apply button. The 

software displays the name of the file in the File Name 

text field (3). Use the Select Desired Field for Labels 

drop-down menu (4) to select a field to use as a label for 

each plot point on the map. When you have finished with 

your selections, click the OK button (5). 

 Current File - Select this link to use the currently active file in CRA Wiz and Fair 

Lending Wiz as a coordinate file 

 Existing Files - Click this link to display a list of previously used custom 

coordinate files. Click the checkbox for one or more of the previously used files 

whose coordinates you want to display on the map. 

Important! Previously used custom coordinate files are 

not dynamically linked to source files in CRA Wiz and 

Fair Lending Wiz. If the source loan file changes (for 

example, new records are added), the associated custom 

coordinate file is not updated in Mapper. For this reason, 

you should create a new custom coordinate file if the 

associated loan file is modified. 

4. When you have made your selection(s), click the Apply link located at the top-right corner of 

the Layer Selection pane. 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
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The software plots the branch locations on the map, depicted by 

black stars: 

 
 

And also displays the name of the selected file in the map legend: 

 

5. To change the branch locations from black stars to another symbol or color, double-click the 

desired custom coordinate file listed in the map legend. 
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The software displays the Layer Options - [Name of File] dialog 

box: 

 

6. In the Style section, click the symbol button . 

The software displays the Symbol Style dialog box: 
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7. Use the options in the dialog box to change the symbol type including symbol font family used 

and symbol size, color, and transparency. 

8. When you have made your selections, click the OK button.  

The software displays the Layer Options - [File Name] dialog box. 

9. Click the OK button.  

The software applies your changes to the map symbols. 
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Mapping Peer Branches 

Branch and Deposit data is assembled (by Highline Financial, LLC) from the June 30th Call Reports 

that every financial institution submits to the FFIEC. 

The data can be used in the Mapping module to plot the branches of your institution as well as your 

peers. You can label the individual branches, show the size of the branch based on the deposit 

amounts and view multiple institutions at once. 

 

You use the two-step Branch Mapping Wizard to configure peer branch mapping options. 

To map branches, refer to the following topics:  

Accessing Branch Mapping Wizard 

Using Branch Mapping Wizard - Step 1 Screen 

Using Branch Mapping Wizard - Step 2 Screen 
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Accessing Branch Mapping Wizard 

To map branches, follow these steps: 

1. In the main map screen, click the Map Layer Control link: 

\ 

The software displays the Layer Selection pane: 
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2. Scroll to the very bottom of the pane to display the Branches item in the tree view: 

 

3. Click the Add Branches link: 

 
 

The software displays the Branch Mapping Wizard: 
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Using Branch Mapping Wizard - Step 1 Screen 

You use the Branch Mapping Wizard - Step 1 screen to select peer data source, the mapping area on 

which you want branches to display, and which institutions and/or holding companies you want to 

map. 

To use the Branch Mapping Wizard - Step 1 screen, refer to the following procedures: 

Selecting Peer Data Source 

Selecting Branch Location 

Selecting Bank Type 

Selecting Branch Deposit Amount 

Selecting Specific Institutions 

Confirming Selections 

Note: To clear your selections and reset branch mapping options to their default values, click the 

Reset button located at the bottom left of the Branch Mapping Wizard screen. 

Selecting Peer Data Source 

 From the Select Data Source drop-down menu, select a Peer Data source: 

 

Note: The data sources available in the drop-down menu will depend upon the types of Peer Data 

you have installed in CRA Wiz and Fair Lending Wiz. 
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Selecting Branch Location 

Use the Branch Location options to select the geographic area for which branch locations should be 

drawn on the map: 

 

 All - (1) - Select if you want to display all branches across the U.S. Warning: Because 

the Mapper has to display all branches in the U.S., it will take the system longer than 

normal to render the map. Rendering time can also be affected by the specifications of 

your computer. 

 Map Area - (2) - Select if you want to map branches in the area currently displayed by 

the main map window. 

 Assessment Area - (3) - Use to select a previously defined and saved assessment area in 

which you want to map branches. Click the ellipses button (4) to display the User 

Defined Assessment Areas list box: 

 

To select a saved area, click the checkbox for an area, then click 

the Apply link. The software displays the area in the 

Assessment Areas text field. 

 Custom Area - (5) - Select areas (States, MSAs, and Counties) where you want to map 

branches. Click the ellipses button (6) to display the Select Custom Area list box: 

 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Introduction%20to%20Assessment%20Areas/Introduction%20to%20Assessment%20Areas.htm
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Use the tree view to display and select the areas you want to 

include, then click the Apply link. The software displays the 

selected area(s) in the Custom Area text field. 

Selecting Bank Type 

To map branches by specific institution type, select one or more of the following Bank Type 

checkboxes: 

 

 All 

 Bank 

 Savings & Loan Association 

 Savings Bank 

 Credit Union 

Selecting Branch Deposit Amount 

To map branches by deposit amount, select one of the following Branch Deposit Amount options: 

 

 All - (1) - Select to include branches with all deposit amounts. 

 Checkbox (2) - Select to specify a deposit amount. Use the drop-down menu (3) to specify 

Between, Greater Than (>), or Less Than (<). Use the text boxes (4 and 5) to enter a value 

(if you select greater than or less than operators from the drop-down menu), or a range of 

values (if you select Between from the drop-down menu). 



Mapper User Guide 
 

 88 CRA Wiz and Fair Lending Wiz 

Selecting Specific Institutions 

To map specific institutions you select from a list, use the following Select Specific Institutions 

options: 

 

 Options are divided into Institutions and Holding Companies - (1) 

 All checkboxes - (2) - Select to include all institutions or holding companies. 

 The institutions and/or holding companies you select display in the accompanying text fields - 

(3). 

 Ellipses buttons - (4) - For each type, click to display a list box that you use to select the 

institutions and/or holding companies you want to map: 
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 To sort institution or holding company information in ascending or descending order, 

click the column heading: 

 

 To select an institution or holding company, select its checkbox: 

 

 To clear your selections, click the Clear button located at the bottom left of the dialog 

box: 

 

  To confirm your selections, click the OK button located at the bottom right of the dialog 

box: 
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Confirming Selections 

When you have configured all of the necessary options on the Branch Mapping Wizard - Step 1 

screen, confirm your selections by doing one of the following: 

 Next button - Click to display the Branch Mapping Wizard - Step 2 screen. 

 Finish button - Click to skip the Branch Mapping Wizard - Step 2 screen. The software maps 

the branches.  
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Using Branch Mapping Wizard - Step 2 Screen 

You use the Branch Mapping Wizard - Step 2 screen to configure display options for branches 

including colors used to display branches, and symbol types and options: 

 

To Use the Branch Mapping Wizard - Step 2 screen, refer to the following procedures: 

Note: To clear your selections and reset branch mapping options to their default values, click the 

Reset button located at the bottom left of the Branch Mapping Wizard screen. 

Selecting Display Color - 1 

Max # of Individual Items - 2 

Display Rest Checkbox - 3 

Branch Symbol - 4 
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Color By Drop-Down Menu - 5 

Graduated Symbol Checkbox - 6 

Label By Drop-Down Menu - 7 

Confirming Selections 

Selecting Display Color 

You can change the color used to display a branch on the map.  

To change the display color, follow these steps: 

1. Click the color for an institution or holding company located under the Display column: 

 
 

 The software displays the Color Panel dialog box: 

 

2. Select a new color from the color grid. 

3. Click the OK button. 
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Max # of Individual Items 

To limit the number of branches displayed on the map, enter a numerical value in the Max # of 

Individual Items text field: 

 

Display Rest Checkbox 

Select the Display Rest checkbox to display other branches in a single color grouping: 

 

Branch Symbol 

You use the Branch Symbol button to change the symbol type and style used to display branches on 

the map.  

To modify the branch symbol, follow these steps: 

1. Click the Branch Symbol button to change the type and style of the symbol used to display 

branches on the map: 

 
 

The software displays the Symbol Style dialog box: 
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2. Use the dialog box to select symbol options including: 

 Font Family 

 Font size 

 Symbol type 

 Color 

3. Click the OK button. 

Color By Drop-Down Menu 

You use the Color By drop-down menu to select the type of institution for which you want to 

display colors: 

 

Available types include: 

 Institution  

 Holding Companies 

 Bank Type 

 Default Color 

Graduated Symbol Checkbox 

Select the Graduated Symbol checkbox if you want the size of the symbol displayed on the map to 

correspond with the asset size of the intuition: 

 

The larger the size of the symbol on the map, the greater the assets of the institution. 

Note: This option is enabled by default. 
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Label By Drop-Down Menu 

You use the Label By drop-down menu to select for which type of institution the map will display 

labels: 

 

Available types include: 

 By Branch 

 By Institution 

 By Holding Company 

 By Bank Type 

Confirming Selections 

When you have configured all of the necessary options on the Branch Mapping Wizard - Step 2 

screen, confirm your selections by doing one of the following: 

 Previous button - Click if you need to return to the Branch Mapping Wizard - Step 1 screen. 

 Finish button - Click if you are finished making your selections. The software maps the 

branches. 
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Plotting Address 

If you need to map a single address within your assessment area, use the Plot an Address function. 

Note: The plot an address function requires the installation of valid geocoding address data in 

CRA Wiz and Fair Lending Wiz. 

To plot an address, follow these steps: 

1. In the main Mapper screen, click the Plot an Address link : 

 
  

The software displays the Plot an Address dialog box: 

 

2. Enter the following address information in the provided text fields: 

 Street Address 
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 City 

 State Abbreviation 

 ZIP code (+5) 

Note: If you want the software to zoom to the address when the 

address is plotted on the map, select the Zoom to Address check 

box: 

 

3. Click the Go button. 

The software displays the location of address on the map using a star 

symbol: 

 
 

Note: The Mapper will attempt to geocode the input address with 

regulatory grade geocode setting. These settings cannot be modified 

in this module. If the record is unable to be geocoded, the software 

displays an error message: 
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Saving Map 

To save the map, follow these steps: 

1. Do one of the following:  

 From the File menu, select Save Map As....: 

 

-OR- 

 At the bottom-left of the map screen, click the Save  icon.  

The software displays a dialog box: 
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2. In the Filename text field located at the bottom of the dialog box, enter a name for the map. 

3. Click the Save button. The software saves your map. 
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Accessing Saved Maps 

To access saved maps, follow these steps: 

1. On the Mapper main screen, click the Map Configuration Settings link: 

 

The software displays the Map Settings pane: 
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2. Click the Saved Maps tab: 

 

The software displays the Saved Maps pane: 

 

The Maps tree view lists all of your previously saved maps in 

alphabetical order: 
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4. Click the saved map you want to restore: 

 

5. Click Apply in the upper right-hand corner of the Saved Maps pane: 

 
 

The software restores the saved map. 
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Printing Maps 

To print a map, follow these steps: 

1. Select File > Print. 

The software displays the Layout screen. 

 

The Layout screen contains the following tools: 

 Map Title - Allows you to add a title to the map. 

 Scroll Bars - Allows you to center the map. 

 Size Frame - Allows you to resize the map. 

Note: The area you currently view in the layout screen, is the area that 

will print out as your map. 

2. Double-click on the Map Title. 

The software displays the Map Title box. 

3. In the Map title box, name the map. 

4. Click elsewhere on the map to save the changes. 

5. To change the map title font and style, right-click the map title and select Change Display 

Settings from the contextual menu: 
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The software displays the Font dialog box. 

6. Select a font size from the Size list and click the OK button. 

The software displays the Print layout screen with your updated 

changes. 

 

7. When you are satisfied with how the map will look, select File > Print to print out your map. 
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Note: The exact configuration of your print dialog box depends on 

the type of printer you use. 

8. Click the Print button. 

The software prints the map. 
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Exporting Map 

To export a map, follow these steps: 

1. Select File > Export.... 

The software displays the Export Map as Image dialog box: 

 

2. Enter a name for the map in the File Name text field.  

3. Click the Save as type field. 

The software displays the Save as type drop-down list box. 

4. Select Compuserve Graphic Interchange Format (*.gif) 

Note: The GIF file type is recommended because the resulting file is 

relatively small. 

Note: The default selection is Bitmap Image (.bmp). 
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5. Locate the folder where you want to save the file. 

6. Click the Save button. 

The software saves the file. 
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Chapter 3:  
Premium Mapping Modules 

Premium Mapping content has been added to the CRA Wiz and Fair Lending Wiz Mapper with the 

intent of providing users with a set of powerful mapping tools capable of automating complex spatial 

analysis tasks once performed manually by users. While the Premium Mapping modules were 

designed to be integrated within the functionality of the standard CRA Wiz and Fair Lending Wiz 

Mapper, this functionality will not be available to all users. Premium Mapping is available as an 

add-on license only.  

For more information about this functionality, please contact your Wolters Kluwer Financial 

Services Account Manager at 1-800-261-3111. 

A Premium Mapping license includes the following modules: 

  Location Maps - This module was designed to automate the process of determining the 

service area around your institution’s branch locations. Within the module, a user selects a 

custom coordinate file (for example, a branch file) of their choosing then the desired radius (in 

miles) around their location. With the click of a button, the system will calculate the distance 

to the nearest LMI Tract and provide valuable reporting describing the LMI Tracts within the 

location’s user-defined service area. 

 Assessment Area Maps - The Assessment Area Maps module provides institutions the ability 

to create one base map with the themes, layers, and preference of their choosing and apply 

those settings to any number of the institution’s assessment areas with batch print and export 

functionality. 

 Web Map - A web-based alternative map utility for performing valuable spatial analysis on 

desired geography. Utilizes over 100 demographics and third-party data sets including--but not 

limited to--foreclosures, LIHTC, Bank Failures, peer lending, and CRA Eligibility. 

 Grid Atlas Maps - The Grid Atlas Maps module allows users to perform analysis on large 

geographic areas using an atlas-like grid system. Users will enjoy the flexibility of zooming in 

and out of specific grid panels and the ability to print/export large- and small-scale maps. 

 Time Interval Maps  - The Time Interval Maps module allows a user to select a data file (for 

example, custom coordinate file), and map the activity in the loan by utilizing a slider bar to 

select the specific time period for which the map should display activity (for example, months 

or quarters). This utility provides the user with a dynamic view of their lending over the 

duration of time covered in their data file. 
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For more information about Premium Mapping Modules, refer to the following topics: 

Assessment Areas Map Overview 

Location Map Overview 

Time Interval Map Overview 

Web Map Overview 

Assessment Area Map Overview 

The Assessment Area Map module automates map creation for multiple assessment areas. You can 

create and populate a single assessment area map, then use that map as a template to print and export a 

batch of additional assessment area maps.  

Note: The Assessment Area Map module is only accessible to institutions who have purchased an add-

on Map license to the standard CRA Wiz and Fair Lending Wiz license. This module will be disabled if 

your institution has not purchased it. To purchase this module, please contact your Wolters Kluwer 

Financial Services Account Manager at 1-800-261-3111. 

For more information, refer to the following procedures: 

Accessing Assessment Area Map 

Printing Assessment Area Map(s) 

Exporting Assessment Area Map(s) 
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Accessing Assessment Area Map 

Important! To access the Assessment Areas Map module, you must first create an assessment area map 

in the main Mapper screen. If you do not create an assessment area map and then try to launch the 

Assessment Area Map module, the software displays a warning dialog box and the module will not 

launch. For more information on creating an AA map, refer to the Creating Assessment Area Map 

topics.  

To access the Assessment Area Map module, follow these steps: 

1. Create an assessment area map: 

\ 

Note: For more information on creating an AA map, refer to the 

Creating Assessment Area Map topics.  
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2. Click the Assessment Area Maps button located at the top-right corner of the main Map 

screen: 

 
 

The software displays the Assessment Area Map module: 

 
 

Note: To close the Assessment Area Map module, click the close 

button located on the bottom right side of the screen: 
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Printing Assessment Area Map(s) 

Using the Assessment Areas Map module, you can print maps of multiple assessment areas at one 

time. 

To print one or more assessment area maps, follow these steps: 

1. If you want to display a buffer of census tracts around your assessment area, click the Include 

Tracts Outside Assessment Areas checkbox: 

 
 

The software displays a buffer of tracts outside of your assessment 

area. In the example below, these buffer of tracts appear outside of 

the assessment area border represented by the thick black boundary 

line: 

 



Mapper User Guide 

CRA Wiz and Fair Lending Wiz 113 

2. Click the Print/Export link: 

 
 

The software displays the Select Assessment Areas dialog box: 

 

3. In the Available Assessment Areas list box, select one or more assessment areas that you 

want to print: 
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4. Click the right arrow button: 

 

The software displays the selected assessment areas in the Selected 

Assessment Areas list box: 

 
 

Note: To remove a single assessment area from the list, select it and 

click the left arrow button. To remove all assessment 

areas from the list, click the left-facing double-arrow 

button. 

5. Click the Print button: 

 
 

The software displays the Map Print Layout window: 

Note: The amount of time it takes the software to render the maps 

for printing depends on the number of assessment areas you selected 

in Step 3 and the specifications of your computer. 
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6. Configure map print layout options as follows: 

 To add a map title, double-click Map Title (1) then enter a new map title. 

Note: This title will be used on each map that is printed. 

 Double-click the main map window (2) then place your mouse cursor over the map window 

border to change the width and/or height of the map window or reposition the main map 

window.  

 Double-click the assessment area name text box (3) then place your mouse cursor over the text 

box border to change the width and/or height of the text box or reposition it. 

 

Note: The assessment area name listed in this box is the only item 

that is dynamic for each map, and displays the name of the specific 

assessment area being printed. 

 Double-click the map theme text box (4) or map legend text box (5), then place your mouse 

cursor over the text box border to change the width and/or height of the text box, reposition 

the text box, or delete the text box. 
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Important! If you are printing multiple assessment area maps, the 

layout you configure for the first map applies to all subsequent 

maps. 

7. To save the map layout as a template for future use, select Save Layout from the File menu: 

 
 

The software displays the Open dialog box: 

 

8. Enter a name for the layout in the Filename text field (1) and then click the Save button (2). 

The software saves the layout. 
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9. To print the map(s), select Print... from the File menu: 

 

Note: If you are printing multiple maps, the software displays a 

Warning dialog box: 

 

  Click the Do not display this warning in the future checkbox if you do not want the system 

to display warning when you print multiple maps. 

 Click the OK button to continue. 

The software displays the Print dialog box: 
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Note: The Print dialog that displays on your computer might differ 

from this example, depending on your computer operating system 

version. 

10. Click the OK button. 

The software prints the assessment area map(s). 

Exporting Assessment Area Map(s) 

You can export one or more assessment area maps as an image file in a single process. For convenience, 

you supply the base file name, and the system appends the assessment area name to the base file name 

for each map that is exported. 

Assessment Area maps can be exported in the following graphics formats: 

 Bitmap (.bmp) 

 Windows Metafile (.wmf) 

 Joint Photographic Experts Group (.jpeg) 

 CompuServe Graphic Interchange Format (.gif) 

 Tagged Image File Format (.tiff) 

 Portable Network Graphics Format (.png) 

 Photoshop File Format (.psd) 

To export one or more assessment area maps, follow these steps: 

1. If you want to display a buffer of census tracts around your assessment area, click the Include 

Tracts Outside Assessment Areas checkbox: 

 
 

The software displays a buffer of tracts outside of your assessment 

area. In the example below, these buffer of tracts appear outside of 

the assessment area border represented by the thick black boundary 

line: 



Mapper User Guide 

CRA Wiz and Fair Lending Wiz 119 

 

2. Click the Print/Export link: 
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The software displays the Select Assessment Areas dialog box: 

 

3. In the Available Assessment Areas list box, select one or more assessment areas that you 

want to export: 

 

4. Click the right arrow button: 
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The software displays the selected assessment areas in the Selected 

Assessment Areas list box: 

 
 

Note: To remove a single assessment area from the list, select it and 

click the left arrow button. To remove all assessment 

areas from the list, click the left-facing double-arrow 

button. 

5. Click the Export button: 

 
 

The software displays the Export Map as Image dialog box: 
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6. Configure the following export options: 

 Use the Save in drop-down menu (1) to select a location to save the file(s) (either local or 

network). 

 Enter a name for the saved map file(s) in the File Name text field (2). Note: If you are 

exporting multiple map files, the name you enter in this text field becomes the base file 

name for the batch export. For each map file that is exported, the system appends the 

name of each assessment area to this base file name. For example: 2012 AA_14484 

Boston-Quincy, MA MSA 

 Select an image format in the Save as type drop-down menu (3). 

7. When you have configured export options, click the Save button. 

Note: If you are exporting multiple maps, the software displays a 

Warning dialog box: 

 

  Click the Do not display this warning in the future checkbox if you do not want the system 

to display warning when you export multiple maps. 

 Click the OK button to continue. 

The software exports the assessment area map file(s) to the location you selected in Step 6. 
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Location Map Overview 

You use the Location Map module to plot locations (points) on the map. The software then draws a 

radius around each point and calculates information about the low/moderate income tracts within the 

radius, for example, Distance to Nearest LMI Tract and Population of LMI Tracts within Radius. 

Additionally, when you hover your mouse pointer over a location, the software displays summary 

information about that point in a tool tip. You can also generate a printable and exportable Location 

Report that contains a summary of the LMI tract information for each location and its service area. 

Note: The Location Map module is only accessible to institutions who have purchased an add-on Map 

license to the standard CRA Wiz and Fair Lending Wiz license. This module will be disabled if your 

institution has not purchased it. To purchase this module, please contact your Wolters Kluwer Financial 

Services Account Manager at 1-800-261-3111. 

For more information, refer to the following procedures: 

Accessing Location Map 

Selecting Location Map File 

Generating Radii 

Location Report  

Accessing Location Map 

Important: CRA Wiz and Fair Lending Wiz Premium Mapping Modules are available to licensed 

customers only. For more information about Premium Mapping licenses, please contact your 

WKFS Account Executive at 1-800-261-3111. 

To access the Location Map, do the following: 

Click the Location Maps  button located at the top-right corner of the main Map screen: 
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The software displays the Location Map module: 

 

Note: To close the Location Map module, click the close button located on the bottom right side of 

the screen: 

  

Selecting Location Map File 

To add locations to a map, you select a custom coordinate file that contains location information (for 

loans, branches, ATMs, etc) that can be plotted on the map.  

Important: The file must be geocoded and contain latitude and longitude coordinate pairs 

Note: You can plot multiple location files on a single map. 

To select a file, follow these procedures: 

Adding New Location Map File 

Selecting Existing Location Map File(s) 
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Adding New Location Map File 

To add a new file with custom coordinates that you want to plot on the Location Map, refer to the 

following procedures: 

Accessing Add Custom Coordinate File Dialog Box 

Selecting New Location Map File 

Filtering Location Map File 

Naming Location Map File 

Selecting Field for Location Labels 

Confirming Location Map File Selections 

Accessing Add Custom Coordinate File Dialog Box 

You use the Add Custom Coordinate File dialog box to select file type (1), filter the file (2), 

rename the file (if necessary) (3), and display labels for each location on the map based on a field 

you select (4): 

 

To access the Add Custom Coordinate File dialog box, follow these steps: 

1. In the Location Map module, click the Select a File link: 
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The software displays the Custom Coordinates dialog box: 
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2. Click the Add File link: 

 
 

The software displays the Add Custom Coordinate File dialog box. 

Selecting New Location Map File 

You can select any file that has already been imported into CRA Wiz and Fair Lending Wiz as long 

as it contains latitude and longitude values. 

Note: For more information about importing custom coordinate files into CRA Wiz and Fair Lending 

Wiz so that they are accessible by the Mapper, click here. 

To select a Location Map file, follow these steps: 

1. Click the ellipses button located at the end of the Source File Name text field: 

 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Importing/Importing%20a%20Branch%20File/Importing%20a%20Branch%20File%20Overview.htm
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The software displays an Open dialog box. The dialog box displays 

the files that are currently available in CRA Wiz and Fair Lending 

Wiz. The dialog box is divided into two panes: Folders for the 

various file types are displayed in the left pane (1) and files are 

displayed in the right pane (2): 

 

Note: You cannot select Peer Data. 

2. Click a folder type in the left pane (Mortgage 2004, Small Business and Farm, Consumer, etc): 
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The software displays the files available for that type in the right 

pane. 

3. Select the file: 

 

4. Click the Open button: 

 
 

The software displays the Add Custom Coordinate File dialog box.  

Note: The software displays file path for the selected file in the 

Source File Name text field: 
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Filtering Location Map File 

You can filter the data you want to use when mapping location information. 

To apply a filter to your location file, follow these steps: 

1. In the Add Custom Coordinate File dialog box, click the Add Filter link: 

 

The software displays the Filter dialog box: 
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2. Use the tree view to select filter criteria: 

 

3. Click the Apply button located at the top-right corner of the dialog box: 

 
 

The software displays your filter criteria in the Current Filter area: 
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Naming Location Map File 

If for the purposes of Location Mapping you want to change the default name of the file you have 

selected, follow these steps: 

1. In the File Name text field, select and delete the default file name: 

 

2. Enter a new file name: 

 
 

Important: The new name is used only for display purposes in the 

Mapper module. The name of the file is not permanently changed in 

CRA Wiz and Fair Lending Wiz. For more information about 

renaming a loan file using CRA Wiz and Fair Lending Wiz file 

management, click here. 

Important: You cannot use special characters (#@$%) or spaces in 

the file name. 

Selecting Field for Location Labels 

You can select a field from the file to use as a display label on the Location Map.  

To select a field for location labeling, do the following: 

From the Select Desired Field for Labels drop-down menu, select a field: 

 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Contexual%20Menu%20Commands/Rename.htm
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Confirming Location Map File Selections 

To confirm your file selections, do the following: 

In the Add Custom Coordinate File dialog box, click the OK button: 

 

The software maps the file locations: 
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Selecting Existing Location Map File(s) 

To select a previously created custom coordinate file or files, follow these steps: 

1. In the Location Map module, click the Select a File link: 

 
 

The software displays the Custom Coordinates dialog box: 

 

2. Under the Existing Files folder, select one or more files that you want to map: 
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3. Click the Done button located at the bottom right of the dialog box: 

 
 

The software maps the file locations: 
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Generating Radii 

You use the Location Map Draw Circles function to draw radii around each location plotted on the 

map. The software then does a calculation for the presence of low-to-moderate income tracts within the 

selected radius. You can display summary information for each radius by using the Map pointer tool, 

which displays the information in a tool-tip when you mouse over individual locations. 

To generate location radii, follow these steps: 

1. Plot locations on the map: 

 

2. In the Desired Radius Around Each Location text field, enter a value for the size of the radii 

(in miles): 
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3. Click the Draw Circles button: 
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The software draws radii around each location plotted on the map: 

 
 

Note: The time it takes to render the radii depends up on the number of plotted locations along 

with the specifications of your computer. Rendering may take an extended period of time when 

working with large files. 

Note: To change the size of the radii after you have drawn them on 

the map, repeat Steps 2 and 3. 

4. To view summary information for each radius, hover your mouse pointer over a mapped 

location. 
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The software displays the information in a tool-tip: 

 
 

Note: To remove radii from the map, click the Clear button: 

 
 

The software displays a confirmation dialog box. Click the 

OK button. The software removes the radii. 



Mapper User Guide 
 

 140 CRA Wiz and Fair Lending Wiz 

Location Report 

You can generate a printable and exportable Location Report based on Location Map data. The report 

contains a summary of the data points displayed on the Location Map. 

  

To generate, print, and export a Location Report, refer to the following procedures: 

  

Generating Location Report 

  

Printing Location Report 

  

Exporting Location Report 

Generating Location Report 

To generate the Location Report, follow these steps: 

1. Plot locations and draw radii on the map: 

 

2. Click the Location Report link located at the bottom of the Location Map module: 
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The software generates the report: 
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Note: To close the report, click the Close Report button located at 

the bottom right corner of the report screen: 

 

Printing Location Report 

To print a Location Report, follow these steps: 

1. Generate the Location Report. 

2. In the report tool bar, click the Print button: 

 

3. The software displays a Print dialog box: 
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Note: The Print dialog that displays on your computer might differ 

from this example, depending on your computer operating system 

version. 

4. Use the dialog box to configure print options, then click the Print button. 

The software prints the report. 

Note: To close the report, click the Close Report button located at 

the bottom right corner of the report screen: 

 

Exporting Location Report 

You can export a Location Report in the following formats: 

 Excel - Microsoft Excel (spreadsheet) format 

 PDF - Portable Document Format 

 Word - Microsoft Word (word processing document) format 

To export a Location Report, follow these steps: 

1. Generate the Location Report. 

2. In the report tool bar, click the Export  button: 
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The software displays the following options: 

 Excel 

 PDF 

 Word 

 

4. Select an option. 

The software displays the Save As dialog box: 

 

5. Use the dialog box controls to select a location to save the report (local or network) and also 

name the report. 

6. Click the Save button. 
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The software exports the report in the format you selected in Step 3. 

Note: To close the report, click the Close Report button located at 

the bottom right corner of the report screen: 
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Time Interval Map Overview 

You use the Time Interval Maps module to plot records of the duration of activity period of selected 

loan file. You can specify a date field in the data file on which you want to perform analysis, and the 

Time Interval Maps module will calculate the activity period, and then create a slider bar with 

specific time intervals consistent with that of the selected data file.  

For example, if you select Action Date (default) as the desired date field for analysis and the activity 

for the file was for a single year, the Time Interval Maps module will generate a slider bar with 

monthly intervals. By positioning the slider over the individual months indicated in the bar, you can 

plot the year-to-date activity for the specified month. Maps generated with the Time Interval Maps 

display the spatial distribution of lending activity over the duration of the year. Maps of individual 

time intervals can be exported or printed in batches for convenience. 

For more information, refer to the following procedures: 

Accessing Time Interval Map 

Selecting Time Analysis Field 

Using Time Slider 

Saving Time Interval Map 

Printing Time Interval Map 

Exporting Time Interval Maps 
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Accessing Time Interval Map 

Important: CRA Wiz and Fair Lending Wiz Premium Mapping Modules are available to licensed 

customers only. For more information about Premium Mapping licenses, please contact your 

Wolters Kluwer Financial Services Account Executive at 1-800-261-3111. 

To access the Time Interval Map, following these steps: 

1. Launch the Mapper. 

2. Display an assessment area map. 

3. Click the Time Interval Map   button located at the top-right corner of the main Mapper 

screen: 

 

The software displays the Time Interval Map module: 
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Note: To close the Time Interval Map module, click the close button located on the bottom 

right side of the screen: 

 

Selecting Time Analysis Field 

The Time Interval Map uses date information from your loan data file. These date fields might 

include action dates, application dates, or rate lock dates, for example. The system displays any 

applicable date fields from your loan file as selectable options in the Analysis Field drop-down 

menu. Use the drop-down menu to select which date field you want to analyze on the map. 

Note: Date information is pulled from the current file  as set in CRA Wiz and Fair Lending Wiz File 

Management. If you want to perform time analysis on a different file, do the following: 

1. Change the current file in CRA Wiz and Fair Lending Wiz 

2. Refresh the Mapper 

3. Re-open the Time Interval Map 

To select a time field to analyze, do the following: 

1. Click the Analysis Field drop-down menu located at the bottom of the Time Interval Map 

screen: 

 

2.  The software displays a list of available date fields: 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Setting%20Current%20File.htm
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3. Select the date field you want to analyze. 

The software updates the time slider: 

 

Note: For more information on using the time slider, refer to the Using Time Slider topic. 
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Using Time Slider 

Use time slider located below the map to display the time intervals for the time analysis field you 

select: 

 

The software displays date plots cumulatively, so, for example, if you move the slider from the 

month of January to the month of March, the software displays date plots for January, February, and 

March. 

Note: For loan files with year-long date information, the software displays the time scale on the 

slider as months. For loan files with multi-year date information, the software displays the time scale 

in quarters. 

To use the time slider, do the following: 

Click and slide the slider button to the desired time interval (ie, month or quarter): 
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The software displays the time plots for the selected time interval: 

 

Saving Time Interval Map 

To save a time interval map, follow these steps: 

1. Do one of the following:  

 From the File menu, select Save Map As....: 

 

-OR- 

 At the bottom-left of the map screen, click the Save  icon.  

The software displays a dialog box: 
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2. In the Filename text field located at the bottom of the dialog box, enter a name for the map. 

3. Click the Save button. The software saves your time interval map. 

Printing Time Interval Map 

Using the Time Interval Map module, you can print maps of multiple time interval plots at one time. 

To print a time interval map, follow these steps: 

1. Click the Print/Export link: 

 
 

The software displays the Select Time Intervals dialog box: 



Mapper User Guide 

CRA Wiz and Fair Lending Wiz 153 

 

2. In the Available Intervals list box, select one or more time intervals that you want to print: 

 

3. Click the right arrow button: 

 
 

The software displays the selected assessment areas in the Selected 

Intervals list box: 
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Note: To remove a single assessment area from the list, select it and 

click the left arrow button. To remove all assessment areas 

from the list, click the left-facing double-arrow button. 

4. Click the Print button: 

 
 

The software displays the Map Print Layout window: 

Note: The amount of time it takes the software to render the maps 

for printing depends on the number of time intervals you selected in 

Step 3 and also the specifications of your computer. 
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5. Configure map print layout options as follows: 

 To add a map title, double-click Map Title (1) then enter a new map title. 

Note: This title will be used on each map that is printed. 

 Double-click the main map window (2) then place your mouse cursor over the map 

window border to change the width and/or height of the map window or reposition the 

main map window. 

 Double-click the time interval name text box (3) then place your mouse cursor over the 

text box border to change the width and/or height of the text box or reposition it. 

Note: The time interval listed in this box is the only item that 

is dynamic for each map, and displays the name of the 

specific time interval being printed. 

 Double-click the map theme text box (4) or map legend text box (5), then place your 

mouse cursor over the text box border to change the width and/or height of the text box, 

reposition the text box, or delete the text box. 
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Important! If you are printing multiple time interval maps, the layout 

you configure for the first map applies to all subsequent maps. 

6. To save the map layout as a template for future use, select Save Layout from the File menu: 

 

The software displays the Open dialog box: 

 

7. Enter a name for the layout in the Filename text field (1) and then click the Save button (2). 

The software saves the layout. 

8. To print the map(s), select Print... from the File menu: 
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Note: If you are printing multiple maps, the software displays a 

Warning dialog box: 

 

 Click the Do not display this warning in the future check box if you do not want the system 

to display warning when you print multiple maps. 

 Click the OK button to continue. 

The software displays the Print dialog box: 
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Note: The Print dialog that displays on your computer might differ 

from this example, depending on your computer operating system 

version. 

10. Click the OK button. 

The software prints the assessment area map(s). 

Exporting Time Interval Maps 

You can export one or more time interval maps as an image file in a single process. For convenience, 

you supply the base file name, and the system appends the assessment area name to the base file name 

for each map that is exported. 

Time interval maps can be exported in the following graphics formats: 

 Bitmap (.bmp) 

 Windows Metafile (.wmf) 

 Joint Photographic Experts Group (.jpeg) 

 CompuServe Graphic Interchange Format (.gif) 

 Tagged Image File Format (.tiff) 

 Portable Network Graphics Format (.png) 

 Photoshop File Format (.psd) 

To export one or more time interval area maps, follow these steps: 

1. Click the Print/Export link: 

 

The software displays the Select Time Intervals dialog box: 
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2. In the Available Intervals list box, select one or more time intervals that you want to export: 

 

3. Click the right arrow button: 

 
 

The software displays the selected time intervals in the Selected 

Assessment Areas list box: 
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Note: To remove a single assessment area from the list, select it and 

click the left arrow button. To remove all assessment areas 

from the list, click the left-facing double-arrow button. 

4. Click the Export button: 

 
 

The software displays the Export Map as Image dialog box: 

 



Mapper User Guide 

CRA Wiz and Fair Lending Wiz 161 

5. Configure the following export options: 

 Use the Save in drop-down menu (1) to select a location to save the file(s) (either local or 

network). 

 Enter a name for the saved map file(s) in the File Name text field (2). Note: If you are 

exporting multiple map files, the name you enter in this text field becomes the base file 

name for the batch export. For each map file that is exported, the system appends the 

name of the month or quarter to this base file name. For example: File Name_January, 

File Name_February, File Name_March. 

 Select an image format in the Save as type drop-down menu (3). 

6. When you have configured export options, click the Save button. 

Note: If you are exporting multiple maps, the software displays a 

Warning dialog box: 

 

 Click the Do not display this warning in the future check box if you do not want the system 

to display warning when you export multiple maps. 

 Click the OK button to continue. 

The software exports the time interval map file(s) to the location you selected in Step 5. 
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Web Map Overview 

The CRA Wiz and Fair Lending Wiz WebMap module provides institutions with a web based map 

utility that allows users to view key performance context indicators and demographic information for 

desired geographies. 

Note: The WebMap module is only accessible to institutions who have purchased an add-on Map 

license to the standard CRA Wiz and Fair Lending Wiz license. This module will be disabled if your 

institution has not purchased it. To purchase this module, please contact your Wolters Kluwer 

Financial Services Account Manager at 1-800-261-3111. 

For more information on using the Map module, refer to the following procedures: 

Accessing Web Map 

Web Map Settings 

Basic Map Tasks 

Synchronizing Data 

Managing Synchronized Data 

Adding Data to Map 

Adding Sites 

Adding Data Files 

Adding Assessment Areas 

Using Map Legend 

Setting Your Location 

Working with Map Title 
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Accessing WebMap 

To access the CRA Wiz and Fair Lending Wiz WebMap, follow these steps: 

1. In the CRA Wiz and Fair Lending Wiz side bar, click the Analysis tab: 

 
 

The software displays the Analysis tool bar: 
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2. Click the WebMap button: 

 

A WebMap session launches in a separate Internet browser window. 

 

Note: If your institution is not licensed for this module, the system will display a separate 

Internet browser window with information about how to purchase the Map module. 
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Web Map Settings 

Important! The Web Map module is only accessible to institutions who have purchased an add-on 

Premium Map license to the standard CRA Wiz and Fair Lending Wiz Mapper. This module will be 

disabled if your institution has not purchased it. To purchase this module, please contact your 

Wolters Kluwer Financial Services Account Manager at 1-800-261-3111. 

Important! You must have Administrative privileges to access these settings. For more 

information, please contact your Wolters Kluwer Financial Services Account Manager at 1-800-

261-3111. 

When you have been licensed to use the Web Map module, you use the Settings pane in CRA Wiz 

and Fair Lending Wiz System Maintenance to enter your provided Web Map user account 

information, and to also enable synchronization of data files and/or saved assessment areas. 

To configure Web Map settings, follow these steps: 

1. Access the CRA Wiz and Fair Lending Wiz System Maintenance module.  

2. Click the Settings tab: 

 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/System%20Maintenance/System%20Settings.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/System%20Maintenance/Introduction%20to%20System%20Maintenance/Introduction%20to%20System%20Maintenance.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/System%20Maintenance/Introduction%20to%20System%20Maintenance/Accessing%20System%20Maintenance.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/System%20Maintenance/Introduction%20to%20System%20Maintenance/Introduction%20to%20System%20Maintenance.htm
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The software displays the Settings pane: 

 

3. In the Web Map section located in the lower left corner of the screen, enter into the provided 

fields, the Web Map user name and password provided by WKFS Support during your Web 

Map licensing and implementation: 

Note: If you have not received this information, please contact WKFS Support at 1-800-261-

3111. 

 

4. To enable synchronization of data files between CRA Wiz and Fair Lending Wiz and Web 

Map, click the Enable Synchronization of Data Files check box: 
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5. To enable synchronization of saved assessment areas between CRA Wiz and Fair Lending Wiz 

and Web Map, click the Enable Synchronization of Assessment Areas check box: 

 

6. Click the Apply button to save your changes: 

 



Mapper User Guide 
 

 168 CRA Wiz and Fair Lending Wiz 

Basic Map Tasks 

To perform basic mapping tasks, refer to the following procedures: 

 Zooming In and Out 

 Panning 

 Click to Identify 

 Adding Geographic Boundaries 

 Clearing Location 

 Printing and Saving Map 

 Closing Map 

Zooming In and Out 

Use the track wheel on a your mouse to zoom into the map to see neighborhood level data, and zoom 

out to see regional or national views. Additionally, you can manipulate the zoom level by changing 

the setting on the zoom tool available in the upper left hand corner of the map view. 

 

Panning 

To pan around the map, hold down your left mouse button, drag the map to your desired location, 

and release the mouse button. Repeat as necessary. 

Click to Identify 

Click on any shaded area of the map to find the exact value for that location. This is called the "Click 

to Identify" bubble. The bubble will also show you the values for the larger geographies in which the 

shaded area sits: 
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Adding Geographic Boundaries 

Geographic boundaries including Zip Codes, Counties, MD/MSA, Flood Zones, and Census Tracts 

are optional map layers that can be added to a map. These boundaries are located in the lower right 

hand corner of the map. 

 To add a boundary layer to your map, click the box beside the desired boundary layer: 

 

 To remove a boundary layer, click box beside the desired boundary layer to remove the check 

mark. 
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Clearing Location 

To clear a location or outline set in the Set Location toolbar, click the Clear Location link in the 

lower right-hand corner of the map: 
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Printing and Saving Map 

To print and/or save a map, refer to the following procedures. 

Printing Map 

Saving Map 

Printing Map 

To print the map, follow these steps: 

1. Select the Print  button located in the lower left-hand corner of the map. 

The system displays the File Download dialog box: 

 

2. Click the Open button. The system opens an image of the map. 

3. From the File menu, select Print.  

4. Use the resultant Print dialog box to configure print options and print the map. 
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Saving Map 

To save a copy of the map in JPEG format, following these steps: 

1. Select the Print button located in the lower left-hand corner of the 

map.The system displays the File Download dialog box: 

 

2. Click the Save button. The system displays the Save dialog box. 

3. Use the dialog box controls to name the map and select a save location. 

Closing Map 

To close the map, click the close (X) button located in the top right corner of the Map's Internet 

browser window. 
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Synchronizing Data 

You can synchronize (upload) existing loan data files and saved assessment areas in CRA Wiz and 

Fair Lending Wiz to Web Map for analysis.  

Important! Before synchronizing your loan files and assessment areas, you must enable this feature 

in CRA Wiz and Fair Lending Wiz System Maintenance. For more information, refer to the Web 

Map Settings topic. 

Note: For procedures on how to manage CRA Wiz and Fair Lending Wiz data files and assessment 

areas that you have synchronized with Web Map, refer to the Managing Synchronized Data topic. 

For more information, refer to the following sections: 

Synchronizing Loan Data with Web Map 

Synchronizing Assessment Areas with Web Map 

Synchronizing Loan Data with Web Map 

You use this command to synchronize (upload) loan data files to Web Map for mapping analysis. 

Important! Your loan data file must be geocoded before it can be synchronized to Web Map. For 

more information about geocoding, click here. 

Important! If you delete a loan file from the system using the Delete contextual menu command in 

CRA Wiz and Fair Lending Wiz File Management module, the file is also deleted from Web Map. 

To synchronize loan data files with Web Map, follow these steps: 

1. In the File Management screen in CRA Wiz and Fair Lending Wiz, use the tree view to select 

the loan data file you want to synchronize with Web Map: 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/System%20Maintenance/System%20Settings.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Geocoding/Introduction%20to%20Geocoding/Introduction%20to%20Geocoding.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Geocoding/Introduction%20to%20Geocoding/Introduction%20to%20Geocoding.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Contexual%20Menu%20Commands/Delete.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Introduction%20to%20File%20Management/Introduction%20to%20File%20Management.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Introduction%20to%20File%20Management/Introduction%20to%20File%20Management.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Introduction%20to%20File%20Management/Understanding%20File%20Management.htm


Mapper User Guide 
 

 174 CRA Wiz and Fair Lending Wiz 

 

2. Right-click the file. 

The software displays a contextual menu: 
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3. Select Synchronize with Web Map: 

 

The software displays a dialog box confirming that you want to synchronize "X" amount of 

records (where "X" represent the number of loan records in the file) with Web Map: 

 

4. Click the OK button. 

The software synchronizes the loan data file with Web Map. 

Note: The time it takes to upload a data file to Web Map will depend on the size of the file. 

While small files may take just a couple minutes, larger files could take some time to process. 

For example, a file containing 200,000 records can take 10 minutes to fully synchronize 

between CRA Wiz and Fair Lending Wiz and Web Map. 

Note: During synchronization, the software changes the Synchronize with Web Map menu 

option to Synchronizing with Web Map and disables the command (grayed out): 

 



Mapper User Guide 
 

 176 CRA Wiz and Fair Lending Wiz 

After synchronization is complete, the software re-enables the menu option. 

Note: For procedures on how to access the loan data file in Web Map, click here. 

Note: After synchronizing data files and assessment areas to Web Map, you may need to 

refresh the Web Map browser window to see the synchronized data and assessment areas. 

Synchronizing Assessment Areas with Web Map  

You can synchronize (upload) your saved assessment areas to Web Map for analysis. 

Important! If you delete a saved assessment area from the system using the Delete contextual-menu 

command in CRA Wiz and Fair Lending Wiz Assessment Areas module, the file is also deleted from 

Web Map. 

To synchronize an assessment area with Web Map, do the following: 

1. In the Create Areas screen in CRA Wiz and Fair Lending Wiz, select the saved area you want 

to synchronize with Web Map: 

 

2. Right-click the saved area. 

The software displays a contextual menu: 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Creating%20and%20Saving%20%20Assessment%20Areas.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Introduction%20to%20Assessment%20Areas/Introduction%20to%20Assessment%20Areas.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Introduction%20to%20Assessment%20Areas/Introduction%20to%20Assessment%20Areas.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Creating%20and%20Saving%20%20Assessment%20Areas.htm
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3. Select Synchronize with Web Map: 

 

The software synchronizes the assessment area with Web Map. 
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Note: During synchronization, the software changes the Synchronize with Web Map menu 

option to Synchronizing with Web Map and disables the command (grayed out): 

 

After synchronization is complete, the software re-enables the menu option. 

Note: For procedures on how to access the assessment area in Web Map, click here. 

Note: After synchronizing data files and assessment areas to Web Map, you may need to 

refresh the Web Map browser window to see the synchronized data and assessment areas. 

Managing Synchronized Data 

You use the Web Map pane in System Maintenance to manage data files and saved assessment 

areas that you have synchronized with Web Map. 

Important! The Web Map module is only accessible to institutions who have purchased an add-on 

Map license to the standard CRA Wiz and Fair Lending Wiz license. This module will be disabled if 

your institution has not purchased it. To purchase this module, please contact your Wolters Kluwer 

Financial Services Account Manager at 1-800-261-3111. 

Important! You must have Administrative privileges to access these settings. For more 

information, please contact your Wolters Kluwer Financial Services Account Manager at 1-800-

261-3111. 

The Web Map Upload List tree view displays all of the Data Files and Assessment Areas that are 

currently synchronized with Web Map: 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/System%20Maintenance/Introduction%20to%20System%20Maintenance/Introduction%20to%20System%20Maintenance.htm
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Click the plus (+) sign located next to a folder to display the folder's contents: 

 

 Data (loan) Files are organized by Census Year (2000 and 2010), and then broken down by the 

following categories: 

 Auto 

 Consumer 

 Deposit 

 Mortgage 

 Mortgage 2004 

 Other 

 Small Business and Farm 

 Small Business Farm and Consumer 

 Assessment Areas are organized by Census Year (2000 and 2010). 
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For more information on using the Web Map settings creen, refer to the following procedures: 

Deleting Data Files 

Refreshing List 

Deleting Data Files 

To delete a data file or assessment area from Web Map, follow these steps: 

Important! Deleting the data file or assessment area from Web Map does not also delete data in 

CRA Wiz and Fair Lending Wiz. 

1. Use the tree view to navigate to the data file or assessment area you want to delete: 

 

2. Click the file to select it: 

 

The software displays a X-mark next to the file. 

3. Click the Delete button located in the top right corner of the tree view list box: 
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The software deletes the file and grays out the file name to indicate it has been deleted from 

Web Map: 

 

Refreshing List 

If you have recently added or deleted data files and/or saved assessment areas using the CRA Wiz 

and Fair Lending Wiz File Management or Create Areas modules, you may need to use the Refresh 

List link to update the list of files displayed in the Web Map Upload List. 

To refresh the Web Map Upload list, do the following: 

Click the Refresh List link located in the top left corner of the tree view list box: 

 

The software refreshes the list. 

Note: During the refresh, the software closes any folders or sub-folder you expanded in the tree 

view. 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/File%20Management/Introduction%20to%20File%20Management/Introduction%20to%20File%20Management.htm
../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Introduction%20to%20Assessment%20Areas/Introduction%20to%20Assessment%20Areas.htm
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Adding Data to Map 

Various performance context and demographic indicators are available to add to your map in the left 

hand margin of the Map in the ADD DATA LAYER section. 

 

To add data to your map, move your mouse cursor over the desired category and select a specific 

indicator: 

 

Note: Only one indicator can be applied to a map at a time. Each subsequent indicator selected will 

replace the one previously selected. 
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Adding Sites 

The Add Sites section provides institutions with an additional set of map elements and predefined 

data sets that can be applied to the map. 

The current predefined data sets: 

 FDIC Bank Failures 

 LIHTC (HUD’s Low Income Housing Tax Credits) 

Adding Data Files 

You can apply data files that you have synchronized from CRA Wiz and Fair Lending Wiz to a map. 

1. To access the data file in Web Map, click the Data Files button in the Web Map main screen: 

 

The software displays the Data Files tree view: 
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2. Use the tree view to navigate to the folder containing your loan data file: 

Note: Loan data files are organized by Census Year (2000 and 2010) and then by type (Auto, 

Consumer, Deposit, Mortgage, Small Business, etc).  

 

Note: Mouse over the blue information icon  located next to the loan data file name to 

display a tool tip containing a summary information about the file including the file path 

(where the file is saved), number of records, and the date it was last modified (synchronized 

with Web Map): 

 

3. Click the file.  

The software maps the records in the file: 
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Note: The software also displays a summary of data file information on the bottom left side of 

the map window: 
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Adding Assessment Areas 

You can apply saved assessment areas that you have synchronized from CRA Wiz and Fair Lending 

Wiz to a map. 

To add a synchronized assessment area, follow these steps: 

1. In the Web Map main screen, click the Assessment Areas button: 

 

The software displays the Assessment Areas tree view: 

 

../../Users/mindy.marchetti/AppData/Local/Microsoft/Content/CRA%20Wiz%206.8%20Help/Assessment%20Areas/Creating%20and%20Saving%20%20Assessment%20Areas.htm
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2. Use the tree view to navigate to the folder containing your saved assessment area: 

Note: Assessment areas are organized by Census Year (2000 and 2010). 

 

Note: Mouse over the blue information icon  to display a tool tip containing a summary 

information about the area including name of the saved area, number of tracts, and the date it 

was last modified (synchronized with Web Map): 

 

3. Click the assessment area.  

The software maps the assessment area: 
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Note: The software also displays a summary of assessment area information on the bottom left 

side of the map window: 
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Using Map Legend 

When you create a map with performance context and demographic indicators, the system displays a 

legend in the upper left hand corner of the map: 

 

For more information about the map legend, refer to the following procedures: 

Hide and Display Legend 

Changing Year 

Changing Variable 

Ranges 

Shaded By 

Source 

Clear Data Layer 
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Hide and Display Legend 

To hide the legend from displaying on the map, select the Hide Legend link in the upper right hand 

corner of the legend: 

 

If the legend has been hidden, select the Show Legend link to display the legend. 

 

Changing Year 

The legend displays the data date of the currently selected data as well as alternate year options 

available for view. 

The currently selected year will display in bold orange. 

All other available years will display with active links. To select an alternative year, click the desired 

year: 
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Changing Variable 

Use the Change Variable links to change how data is displayed: 

 

Options include:  

 # (number) 

 $ (Dollar amount) 

 %Ch (percent change) 

Ranges 

The legend displays the values for each range on the map. A good rule is: The darker the color, the 

higher concentration or value of the shaded area: 
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Shaded By 

You use the Shaded by drop-down menu to change the data distribution on the map. Available 

options in this menu will depend on the variable selected as well as the zoom level on the map.  

 

Possible options include:  

 Block Group 

 Census Tract 

 County Subdivision 

 City 

 County 

 Metro Area 

 Congressional District 

 State 

Source 

 To view more information about the source of the data displayed on the map, click the Source link: 

 

The system displays detailed source information in a separate browser window: 
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Clear Data Layer 

To remove a variable or data layer from the map, click the Clear Data Layer link: 
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Setting Your Location 

 

You use the Set Location functionality to zoom to a particular area or point on the map.  

For more information about setting location, refer to the following procedures: 

Search the Map 

Census Tract 

BG (Block Group) 

Congressional District 

Senate 

School District 

State Senate District 

Metro 

Search the Map 

To search the Map, follow these steps: 

1. Click the Search the Map tab. 

2. Enter a specific Address, City, County, State or ZIP Code to which you want to zoom. 

3. Click the Go button. 

Census Tract 

To set a location using Census Tract, follow these steps: 

 

1. Click the Census Tract tab. 

2. Select a state from the from the State drop-down menu. 

3. In the County text box, enter a county name. Note: The Map will auto-suggest a county name 

after typing a few letters of the county name. 

4. In the Census Tract text box, enter a six-digit Census Tract code. 



Mapper User Guide 

CRA Wiz and Fair Lending Wiz 195 

5. Click the Go button. 

 BG (Block Group) 

 

To set a location using Block Group, follow these steps:  

1. Click the BG tab. 

2. Select a state from the from the State drop-down menu. 

3. In the County text box enter the county name. Note: The Map will auto suggest a county 

name after typing a few letters of the county name. 

4. In the Census Tract text box, enter a six-digit Census Tract code. 

5. In the Block Group Code text box, enter a single-digit block code. 

6. Click the Go button. 

Congressional District 

 

To set a location using Congressional District, follow these steps: 

1. Click the Congressional District tab. 

2. Select a State from the State drop-down menu. 

3. Select the desired Congressional District from the Congressional District drop-down menu. 

4. Click the Go button. 

 Senate 

 

To select a location using Senate, follow these steps: 

1. Click the Senate tab. 

2. From the Senator drop-down menu, select the desired Senator.  

3. Click the Go button. 

4. When selected the map should zoom to the state the Senator represents. 

School District 
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To set a location based on School District, follow these steps: 

1. Click the School District tab. 

2. Select a State from the State drop-down menu. 

3. Enter the desired school district in the School District text box. 

4. Click the Go button. 

State Senate District 

 

To set the location based on State District, follow these steps: 

1. Click the State District tab. 

2. Select a State from the State drop-down menu. 

3. From the House District menu, select either Upper House District or Lower House District. 

4.  From the District drop-down menu, select the specific District. 

5. Click the Go button. 

Metro (Metro Areas)  

 

To set a location based on Metro Area, follow these steps: 

1. Click the Metro tab. 

2. Select a State from the State drop-down menu. 

3. Select a Metro Area from the Metro Area drop-down menu. 

4. Click the Go button. 
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Working with Map Title 

When demographics have been applied to the map, a map title will display in the map’s header. The 

map title describes what data is currently displayed on the map: 

 

 To see more information about the data displayed on the map, click the Details button 

 located at the end of the map title. 

 To view more information on the source of the information on the map, click the (see data 

directory) link. 

 To close the map details, select the Close button  located in the map title. 
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How to Contact Wolters Kluwer Financial Services 

Internet 

You can visit us on the Internet at www. wolterskluwerfs.com. 

Phone 

Contact WKFS Technical Support at 800-361-3111. 

Our support staff is available Monday through Friday, 7 A.M. to 7 P.M. EST. Voice mail operates continually, 

allowing you to leave us a message after hours and on weekends. To help us handle your question as 

quickly as possible, have these items available before you call: 

 Product name and version number 

 Customer number 

 Operating system and version number; service pack numbers, if installed. 

E-Mail 

To contact us through email, submit all requests to: support@pciwiz.com. 

Fax 

Send us a fax at 617-535-3155. 

http://www.support.wolterskluwerfs.com/
mailto:support@pciwiz.com
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